DISCLAIMER:

THIS WHITE PAPER IS FOR INFORMATIONAL PURPOSES ONLY, AND MAY CONTAIN TYPOGRAPHICAL ERRORS AND TECHNICAL INACCURACIES. THE CONTENT IS PROVIDED AS IS, WITHOUT EXPRESS OR IMPLIED WARRANTIES OF ANY KIND.

For more information, contact Dell. Information in this document is subject to change without notice.

http://www.dell.com
TABLE OF CONTENTS

TABLE OF CONTENTS ................................................................. 3
TERMINOLOGY/GLOSSARY ......................................................... 5
INTRODUCTION ...................................................................... 6
  Implementing ESXi5.0 on the MD36xxf Storage Array ...................... 7
SUPPORTED HARDWARE AND SOFTWARE .................................. 8
  Hardware Requirements ......................................................... 8
  Supported Operating Systems for MD36xxf array .......................... 8
ARCHITECTURAL SETUP ........................................................... 9
  Connections to an MD36xxf fibre channel array ........................... 10
POWERVAULT MD36xxF STORAGE SETUP AND CONFIGURATION ....... 12
  Step1: Manually Define Hosts by highlighting the Storage Array Name and right clicking .... 12
  Step2: Naming the host .......................................................... 13
  Step3: Adding Host Port Identifiers ......................................... 14
  Step4: Enter an Alias for this Host Port Identifier and then select Add ................................ 14
  Step5: Select VMware as the host type ...................................... 16
  Step6: Host Group name ........................................................ 18
  Step7: Preview Define host ..................................................... 19
  Step8: Creation successful...................................................... 20
  Step9: Define Mappings for LUNs .......................................... 21
  Step10: Assigning other virtual disks to the same host group ............ 23
Connect to the ESX server/vCenter using VI Client and follow the steps below ........................................ 25
Allocating storage via the VMFS method ........................................ 25
  Step1: Go to the configuration tab .......................................... 25
  Step2: Select the Path Tab to view the available paths .................... 27
  Step3: Creating a Datastore from the MD36xxf LUNs ...................... 28
  Step4: Select one of the LUNS from the MD36xxf to create a Datastore ........................................ 30
  Step5: Select Next to create a VMFS partition .............................. 32
  Step6: Enter a Datastore name and select Next ............................ 33
  Step7: Adjust the Maximum file size as needed ........................... 34
  Step8: Review the disk layout and click Finish to add storage ............ 35
  Step9: Configuring VMware Path Selection Policy ....................... 37
CONTACT INFORMATION ........................................................ 38
APPENDIX A ......................................................................... 39
  Clustering with ESX4.1 / Creating DRS Clusters ............................. 39
  Support for vMotion ............................................................. 39
Allocating storage via the RDM LUN method .................................... 40
  Step1: Go to the configuration tab .......................................... 40
  Step2: Select the Path Tab to view the available paths .................... 41
  Step3: Edit Virtual Machine Properties ..................................... 42
Allocating storage via the Fibre Channel NPIV method ....................... 48
  Step1: Requirement for Using NPIV ........................................ 48
  Step2: Edit Virtual Machine Properties ..................................... 48
  Step3: Configure the SAN ..................................................... 50
Step4: Debug
TERMINOLOGY/GLOSSARY

VD == virtual disk
VM == virtual machine
NIC == network interface card
MPIO == Multi-Path I/O
FC == fibre-channel
RDM == Raw Device Map
DVS == Distributed Virtual Switch
HA == high availability
DRS == Distributed Resource Scheduler
MRU == Most Recently Used
RR == Round Robin (load-balancing)
WWN == World Wide Name

NPIV == FIBRE CHANNEL N_PORT ID VIRTUALIZATION. ANSI T11 standard that describes how a single Fibre Channel HBA port can register with the fabric using several worldwide port names (WWPNs).
INTRODUCTION

The Dell™ PowerVault™ MD36xxf storage solution consists of either a single-path or dual-path configuration. The single-path configuration has one controller with four FCIN (host) port connectors. It can be deployed to support up to four hosts non-redundantly or up to sixty-four hosts if cabled through a switch. The dual-path configuration has two controllers with four FCIN (host) ports per controller. Likewise, this dual-path option supports up to four hosts if cabled directly or up to sixty-four hosts if cabled through a switch. For more information, see the Dell PowerVault MD3600f and MD3620f Storage Arrays Deployment Guide.

This document provides instructions to setup the MD36xxf Fibre Channel storage solution for use with VMware® ESXi5.0 Server™ software.

Generally, you can connect multiple hosts to a single local storage system. The actual number of hosts you connect varies depending on the amount of storage installed, sharing between ESX hosts and topology you use.

The order in which you configure individual components on your host server and storage array may vary depending on the type of FC HBA, fibre-channel switch or multi-pathing software used. In general, a logical order of steps may be:

(1) install the FC HBA in the ESX host server
(2) cable the host server to the fibre-channel switch (see Figure 1 in Configuring Fibre Channel with the Dell MD3600f-Series Storage Arrays whitepaper)
(3) install the recommended FC HBA drivers and firmware (see the Support Matrix)
(4) cable the MD36xxf to the fibre-channel switches (again, see Figure 1 in Configuring Fibre Channel with the Dell MD3600f-Series Storage Arrays whitepaper)
(5) configure switch zoning
(6) configure storage on the MD36xxf
(7) configure ESX host(s) and VMs

When multiple hosts connect to the local storage unit, they access storage devices in the unshared mode. The unshared mode does not permit several hosts to access the same VMFS Datastore concurrently. Shared access permits multiple hosts to access the same VMFS Datastore on a LUN.

With the MD36xxf this is accomplished with the use of Host Groups allowing multiple ESX Hosts access to the same virtual disk.
Provisioning of storage on servers in a VM environment is a multi-step process starting with definition of the server names for host access. The fibre-channel connection is then established from the MD36xxf. Then detection and configuration are established as a two-way link with the associated ESX server(s), completing the fibre-channel communication subsystem. The final step allocates the detected storage to the virtual machines (VMs), where all or part of the configured storage can be assigned to individual VMs. Connectivity between the storage array and the host server is provided by FC HBAs.

**IMPLEMENTING ESXi5.0 ON THE MD36XXF STORAGE ARRAY**

This whitepaper addresses features in vSphere5 Client and vCenter5.0 Server as well as showing examples of how to connect this environment to Dell™ PowerVault™ FC arrays.

This whitepaper goes into depth on configuration steps for connecting to a PowerVault™ MD36xxf FC array.

For more details on what’s new in vSphere, see [VMware’s What’s New in vSphere 5.0](#). One of the features in ESXi5.0 is NPIV. It allows a virtual Fibre Channel N_Port to be created on the VMware Host FC HBA. Using this method to allocate storage in a VMware configuration allows for assigning LUN(s) directly to the VMware client(server). This method simplifies the task of managing the SAN by assigning the clients FC N_Port ID as the owner of the LUN(s) on the MD3600f storage array instead of the VMware Host FC NPort ID. Also the task of assigning additional HDD(s) is as simple as going to Dell MDSM and assigning LUN(s) to the Host or Host Group that has the Virtual Machines virtual N_Port ID defined within.

Below are the methods of allocating storage that are supported by the MD3600f:

1. VMFS
2. NFS
3. RDM (Physical, Virtual)

For additional information regarding allocating storage via RDM w/ NPIV please refer to the Appendix.
SUPPORTED HARDWARE AND SOFTWARE

HARDWARE REQUIREMENTS

Refer to the following VMware website for a complete up-to-date list of the prerequisites for installing VMware ESX server.
HTTP://WWW.VMWARE.COM/FILES/PDF/TECHPAPER/VSPHERE-5-ESXI-OPERATIONS-GUIDE.PDF

SUPPORTED OPERATING SYSTEMS FOR MD36XXF ARRAY

ESXi5.0, ESX/ESXi4.1 and ESX/ESXi4.0 are the only supported VMware OSs for MD36xxf. For more information, see both the MD Support Matrix as well as the VMware compatibility guide.
ARCHITECTURAL SETUP

The MD36xxf supports a number of different cabling options. Which one you choose for your configuration depends on the level of redundancy required and/or whether you are using storage array premium features. Coexistence of MD36xxf with iSCSI is not supported.

In cabling an MD36xxf your choices include: Direct-Attached Cabling and SAN-Attached Cabling using Fibre Channel switches. For more information, see Configuring Fibre Channel with the Dell MD3600f-Series Storage Array.

The following setup steps reflect a SAN-Attached Cabling configuration. The key is that each HBA has to have a unique path to both controllers. Note while the diagram below implies Fibre Channel port zoning, zoning by WWN is also supported by the MD3600f.

Figure 1
CONNECTIONS TO AN MD36XXF FIBRE CHANNEL ARRAY

Steps:

Prerequisite: The fibre-channel HBA(s) are installed in the ESX server. Cables have been connected to the fibre-channel switches from both the MD36xxf and the ESX server, both the server and the array are powered on and zoning has been properly performed.

For example, the figure below is taken from a switch interface showing the output of the Fibre Channel Name Server with initiator and target ports logged-in to the switch/fabric.

Figure 2

1) To verify that the fibre-channel HBA is correctly installed login to vCenter and select the ESX host. From the Configuration tab select Storage Adapters. You should see the listing for Fibre Channel Host Adapters. Under Details you will see the FC adapter. Scroll down if necessary, there will be no devices or paths listed until after you have configured the MD36xxf array(Figure1).
Figure 3  Viewing Fibre Channel HBA
POWERVAULT MD36XXF STORAGE SETUP AND CONFIGURATION

Create virtual disks on MD36xxf using steps described in:

DELL POWERVAULT MD3600F AND MD3620F STORAGE ARRAYS DEPLOYMENT GUIDE

After opening the Modular Disk Storage Manager and selecting the MD36xxf storage array to be configured, select the **Mappings** tab.

Note: in the following examples the Storage array is an MD36xxf with virtual disks already configured using the **Configure Storage Array** selection under the **Setup** Tab. The new ESX host being added is named “RK27-R710-2”.

From the **Mappings** tab

**STEP1: MANUALLY DEFINE HOSTS BY HIGHLIGHTING THE STORAGE ARRAY NAME AND RIGHT CLICKING**

Right click on the storage array and then Select Define -&gt; Host

![Figure 4 Defining the Storage Array Host Topology](image)
**STEP2: NAMING THE HOST**

Select a name that matches the naming convention used for the environment that you are configuring. For example “RK27-R710-2”. Leave partitions enabled and select **Next**.

*Figure 5 Naming the Host*

This is required for VMotion. See Appendix for details.
**STEP3: ADDING HOST PORT IDENTIFIERS**

Each physical port on the Fibre Channel HBA has a unique WWN that is used for the FC connection. Using the pull down select the host port identifier of the ESX host that you just specified in Step 2.

![Figure 6 Adding Host Port Identifiers](image)

In the Manage Host Port Identifiers window select **Add**

**STEP4: ENTER AN ALIAS FOR THIS HOST PORT IDENTIFIER AND THEN SELECT ADD**

An alias is used in the topology tree to identify the port. Add a unique alias for this host port such as the one in Step 3, and then select **Add**.
The host port screen will be similar to the one below. Repeat the previous steps for remaining ESX host port identifiers, then select **Next** to continue.

![Figure 7 Host Port Identifier](image-url)
**STEP5: SELECT VMware AS THE HOST TYPE**

Figure 8 Selecting Host Type
If you intend using advanced VMware features such as vMotion then this host will share access with other ESX servers and you will have to create a Host Group. We will create a host group for this example.

![Host Group Question](image)

**Figure 9 Host Group Question**
**STEP6: HOST GROUP NAME**

Enter a host group name that is appropriate for your environment. For this example we used *Falconhead-12dr-HostGroup*.

![Diagram of host group name configuration](image-url)

*Figure 10 Host Group Name*
**STEP7: PREVIEW DEFINE HOST**

If all of the information is correct for your environment select *Finish*.

![Figure 11 Preview (Define Host)](image)

*Figure 11 Preview (Define Host)*
**STEP8: CREATION SUCCESSFUL**

Select **No** at this time. You can add additional Hosts after you have finished configuring the current host.

![Figure 12 Topology Creation Successful](image)

The topology is now defined with all Host Port Identifiers.

![Figure 13 Topology Defined](image)
**STEP 9: DEFINE MAPPINGS FOR LUNs**

*Note*: In this example the Disk Groups and Virtual Disks have already been created using the wizard under the Setup Tab.

In the topology tree expand the *Undefined Mappings* and highlight one of the Virtual Disks. Right Click and select *Define Additional Mappings*.

---

**Figure 14 Selecting a Virtual Disk for mapping**
Remember that the virtual disk is assigned to the host group and not the host. For this example we selected the host group that was defined in the previous steps.

Figure 2 Selecting the Host Group
**STEP10: ASSIGNING OTHER VIRTUAL DISKS TO THE SAME HOST GROUP.**

![Figure 3  Assigning additional virtual disks](image)

Figure 3  Assigning additional virtual disks
After the virtual disks are assigned notice that the host group and its associated hosts are no longer under the default group in the topology. This completes the configuration.

Figure 4 Completed Topology with Assigned Virtual Disks
CONNECT TO THE ESX SERVER/vCENTER USING VI CLIENT AND FOLLOW THE STEPS BELOW.

ALLOCATING STORAGE VIA THE VMFS METHOD

STEP1: GO TO THE CONFIGURATION TAB

Select Storage Adapters. Select the **Fibre Channel Host Adapter** and click **Rescan**. (Do not scan for New VMFS Volumes at this time)

![Rescanning for MD36xxf LUNS](image)

**Figure 18 Rescanning for MD36xxf LUNS**

After the scan completes the newly created LUNs will be visible from the ESX server.
Figure 19 Viewing the new Devices
**Step 2: Select the Path Tab to View the Available Paths.**

Depending on how many LUNs have been configured, verify there are, at least, one active and one standby path to each LUN. In this setup example, because we have only one port assigned, we can verify there are one active and one standby paths.

Figure 20 Viewing the new Paths
**STEP3: CREATING A DATASSTORE FROM THE MD36XXF LUNS**

This is the same as creating a Datastore with any local disk. Begin by selecting *Storage* under Hardware and then select *Add Storage*.

![Figure 21 Creating a Datastore](image_url)
Because Fibre Channel is considered a local SCSI disk the storage type is **Disk/LUN**.

**Figure 5 Fibre Channel as a Disk/LUN**
STEP 4: SELECT ONE OF THE LUN S FROM THE MD36XXF TO CREATE A DATASTORE

Figure 23 Selecting a LUN to create a Datastore
Figure 24 Selecting a VMFS version
**STEP5: SELECT NEXT TO CREATE A VMFS PARTITION**

This screen displays the information about the disk layout.

![Image: Create VMFS Partition](image)

Figure 6 Create VMFS Partition
**STEP 6: ENTER A DATASTORE NAME AND SELECT NEXT**

![Diagram showing the process of entering a datastore name](image-url)

*Figure 7 Enter Datastore name*
STEP7: ADJUST THE MAXIMUM FILE SIZE AS NEEDED.

For this example we used the maximum capacity. Select Next when finished.

Figure 8 Adjust Maximum File Size
STEP8: REVIEW THE DISK LAYOUT AND CLICK **FINISH** TO ADD STORAGE

Figure 28 Review Disk Layout
The new storage is completed and ready to use with VMs.

Figure 29 Configuration Completed for VM usage
**STEP9: CONFIGURING VMWARE PATH SELECTION POLICY**

We can take advantage of several multipathing policies, such as Most Recently Used (MRU) and Round Robin (RR). This allows for greater and better bandwidth utilization than in previous versions of ESX.

To verify the Path Selection Policy on a datastore, select the volume from the vCenter GUI. **Configure -> Storage**. Highlight the datastore and select **Properties**.

From the properties window select **Manage Paths**.

The path selection can be either MRU or RR and the Storage Array Type should be VMW_SATP_LSI.

![Figure 30 Path Selection Policy](image)

Note, the CLI command that makes Round Robin the default PSP for all new disks is:

```
# esxcli storage nmp satp set -s VMW_SATP_LSI -P VMW_PSP_RR
```
CONTACT INFORMATION

HTTP://SUPPORT.DELL.COM/SUPPORT/TOPICS/GLOBAL.ASPX/SUPPORT/PRODUCT_SUPPORT/PRODUCT_SUPPORT _CENTRAL?c=us&cs=555&l=en&s=bizReferences

Dell/VMware alliance home page:

http://www.dell.com/vmware
APPENDIX A

CLUSTERING WITH ESX4.1 / CREATING DRS CLUSTERS

Refer to the following VMware website for a complete up-to-date list of the prerequisites for clustering with ESXi5.0 server.


SUPPORT FOR VMOTION

VMware’s Datacenter Admin Guide, page 214 offers guidance entitled, Storage vMotion Requirements and Limitations. Additionally, VMware vSphere Examples and Scenarios, page 57 describes configuring and using vMotion.

In vSphere5, the configuration to enable vMotion is a single check box on the properties of the hosts’ VMKernel network interface.

Figure 43 vMotion support
ALLOCATING STORAGE VIA THE RDM LUN METHOD

**STEP 1: GO TO THE CONFIGURATION TAB**

Ensure the LUN(s) are assigned to the desired VMware Host by going to Dell MDSM and verifying that the LUN(s) are assigned to the correct Host or Host Group.

Within the VMware vSphere Client - Select *Storage Adapters*. Select the *Fibre Channel Host Adapter* and click *Rescan*. (Do not scan for New VMFS Volumes at this time)

![Rescanning for MD36xxf LUNS](image)

Figure 31 Rescanning for MD36xxf LUNS

After the scan completes the newly created LUNs will be visible from the ESX server.
**STEP 2: SELECT THE PATH TAB TO VIEW THE AVAILABLE PATHS.**

Depending on how many LUN(s) have been configured, verify there are, at least, one active and one standby path to each LUN. In this setup example, because we have only one port assigned, we can verify there are one active and one standby paths.

![Viewing the new Paths](image_url)

**Figure 32 Viewing the new Paths**
STEP3: EDIT VIRTUAL MACHINE PROPERTIES

Right click the VM that you want to add a LUN(s) to. Choose **Edit** Setting. The Virtual Machine Properties pop-up will appear.

Under the **Hardware** tab select the **Add** button.

![Image of Virtual Machine Properties](image)

Figure 33 Virtual Machine Properties
1. Select the “Hard Disk” under the “Choose the type of device you wish to add”

Figure 34 Add Hardware
2. Select “Raw Device Mapping”

3. Select the desired LUN to add to the Virtual Machine.
4. Specify whether you want LUN mapping for the RDM LUN to be stored with the Virtual Machine or with another datastore.
5. Select Compatibility Mode. Choose Virtual

![Select Compatibility Mode](image.png)

**Figure 38 Select Compatibility Mode**
6. Advance Options: Specify the Virtual Device Node, and Mode

![Specify the Virtual Device node](image)

Figure 39 Specify the Virtual Device node

7. Ready to Complete. If everything is complete click the **Finish** button to add this LUN to the Virtual Machine.

For more details on RDM LUN(s) please refer to VMware vSphere Storage Guide below.

ALLOCATING STORAGE VIA THE FIBRE CHANNEL NPIV METHOD

STEP1: REQUIREMENT FOR USING NPIV
Refer to pg 42 of the vSphere Storage Guide for ESXi 5.0 for details regarding the requirement for using and limitations of NPIV.

NPIV can only be used for virtual machines using RDM LUN(s).

The FC HBA being used must support NPIV. See HBA vendor.

Fibre Channel switch(es) being used must support NPIV.

STEP2: EDIT VIRTUAL MACHINE PROPERTIES
Make sure the virtual machine you want to configure is in the power off state

Right click the VM that you want to configure NPIV. Choose **Edit** Setting. The Virtual Machine Properties pop-up will appear.

Click the **Options** tab.

![Figure 40 Virtual Machine Properties](image-url)
1. Click on the Fibre Channel NPIV Setting on the Left Panel.

![Figure 41 Select FC NPIV setting](image)

2. Un-check the box for the **Temporarily Disable NPIV for this virtual machine**
3. Click on **Generate new WWNs**
4. Specify the number of WWPN(Fibre Channel World Wide Port Names) you want to create for this virtual machine.
5. Click **OK** to generate the WWPN.
6. Record the WWPN(s) that the VMware Host generated for this Virtual Machine.

![Image of VMware WWPN configuration](image)

**Figure 42 Record the WWPNs**

**STEP3: CONFIGURE THE SAN**

1. Add the new WWPN generated to Fibre Channel fabric.
   a. Create new zone for each generated WWPN.
   b. Add the physical WWPN of the Fibre Channel HBA to the zone that you want the generated WWPN to utilize.
   c. Manually add the generated WWPN to this zone.
   d. Add the new zone(s) to the Active Fabric Configuration

2. Configure the Dell MDSM
   a. Create a Host Group
   b. To this new Host Group define a Host with the physical WWPN of the Fibre Channel HBA that you want the virtual WWPN to use.
c. Define a Host within the Host Group with the virtual WWPN. You will need to add manually the WWPN to this Host definition.

d. Assign LUN(s) to this Host Group.


**STEP4: DEBUG**

1. Check the Fibre Channel Name Server to see if the new WWPN are logged into the Fibre Channel switch.

2. If not then please check the following.
   a. Recheck the zone to make sure both the virtual WWPN and the physical WWPN are defined with the zone and that the zone is defined within the active Fibre Channel Configuration.
   b. Recheck to make sure the MDSM Host Groups and Hosts are define correctly. Check to see if the manually entered WWPN for the newly generated WWPN is correct.